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LESSON 8 Rounding and Nesting Functions EX-1

Concepts Review

True/False Questions
Each of the following statements is either true or false. Indicate your 
choice by circling T or F.

 1. The INT and ROUND functions use the same arguments.

 2. An integer is a whole number, a nondecimal number.

 3. Excel uses a serial number system for dates.

 4. A nested function is placed in the cell below the first formula.

 5. You can hide a worksheet in a workbook.

 6. A hyperlink is a blinking cell with a formula.

 7. An XLS file has all the same features and functions as an XLSX file.

 8. To convert a fraction of a day to hours, multiply by 365.25.

Short Answer Questions
Write the correct answer in the space provided.

 1. What is the term used to describe a function inside a function?

 2. What would this function display in the cell �INT(3.5643)?

 3. What button, when clicked, reveals the Top/Bottom Rules command?

 4. What does a hyperlink do?

 5. Which function inserts the current date?

 6. How can you convert days into years?
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 7. How would Excel display this value �ROUND(1.567,2) in the cell?

 8. Name two functions that are often used in nested formulas.

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 
answers. Support your answers with examples from your own experience, 
if possible.

 1. How would you determine the number of days until Christmas?

 2. Which function do you think has more value in business use: INT or 
ROUND? Why?

Skills Review

Exercise 8-15
Use the INT and ROUND functions.

 1.  Open Miles&Bulk and save it in your Lesson 8 folder as [your initials]8-15.

 2.  On the DeliveryMiles sheet, format cell A1 as 18-point 
Calibri. Make the labels in row 3 bold. Then make all 
three columns 27.86 (200 pixels) wide.

 3. Use the INT function by following these steps:

   a. Key =int in cell C4 and press .

   b. Click cell B4 and press .

   c. Copy the formula in cell C4 to cells C5:C8.

 4. Format rows 3:8 each 22.50 (30 pixels) high.

 5.  Insert a column at column A. Apply a double-line Outline border to cells 
A2:E9. Right-align cells C3 and D3. Apply a dotted middle horizontal 
and bottom border to cells B3:D8.

 6.  Move the label in cell B1 to cell A1 and center it across the appropriate 
selection of cells. Set landscape orientation and horizontal centering. 
Add a footer.

 7.  On the BulkCosts sheet, click cell C6. Key = and click cell B6. Press  
three times to make the column reference absolute. Key * and click cell 
C5. Press  two times to make the row reference absolute. Press .

REVIEW

Drag across three column headings to 
select them and then set the width.
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 8. Copy the formula in cell C6 to cells C7:E14.

 9. Use the ROUND function by following these steps:

 a.  Copy cells A6:B14 to cells A19:A27. Copy cells C5:E5 to cells C18:E18.

 b. Click cell C19 and click the Formulas tab.

 c.  Click the Math & Trig button  and choose ROUND.

 d. Click cell C6 for the Number box. Click in the Num_digits box and key 
0. Click OK.

 e. Copy the formula in cell C19 to cells C20:E27.

 10.  Format cells C6:E14 and cells C19:E27 as Accounting. 
Apply Tan, Background 2 fill to every other row, 
starting at rows 6 and 19.

 11.  Center the main labels across the data and center the 
page horizontally.

 12. Add a header using a 9-point font for each section.

 13. Prepare and submit your work. Save and close the workbook.

Exercise 8-16
Use date and time arithmetic.

 1.  Open PTWorkers and save it as [your initials]8-16 in your Lesson 8 
folder.

 2.  On the Status sheet, key  =today() in cell A20. Edit cell A5 to show your 
first and last name.

 3.  Use date arithmetic by following these steps:

 a. Click cell C4 and key = to start the formula.

 b. Click cell A20 and press .

 c. Key – and click cell B4. Press .

 d.  Click cell C4 and press � . Choose Number as 
the Category and use 2 decimal places. Click OK.

 e. Copy the formula in cell C4 to cells C5:C8.

 f. Click cell D4, key =(, and click cell A20. Press .

 g.  Key – and click cell B4. Key )/365.25 and press 
.

 h. Format cell D4 as Number with 2 decimal places.

 i. Copy the formula in cell D4 to cells D5:D8.

 4. Format cells D4:D8 as 12-point Calibri.

 5.  Insert a column at column A and a row at row 1. Set an Outline border 
for cells A1:F10. Set dashed middle horizontal and bottom borders for 
cells B5:E9.

 6.  Select cells B2:E3 and use Center Across Selection. Right-align the labels 
in row 4.

NOTE

The formula multiplies the cost per unit by 
a quantity of 10500 units.

NOTE

Subtract the hire date from today to 
determine how long an employee has 

worked at the shop.

REVIEW

The subtraction is enclosed in 
parentheses, so it is calculated first.

LESSON 8 Rounding and Nesting Functions EX-3
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 7.  Click the Microsoft Office Button  and hover at Print. Choose Print 
Preview. Click to select Show Margins. Drag the left margin marker to set 
a 1-inch margin.

 8.  On the PartTimeHours sheet, replace Tom Santana’s name (C6 and C12) 
with your first and last name.

 9. Use time arithmetic by following these steps:

 a. Click cell D5, key =(, and click cell C5.

 b. Key – and click cell B5.

 c. Key )*24 and press .

 d. Copy the formula in cell D5 to cells D6:D15.

10. Center the labels in cells A1:A2 across the data.

11.  Click the Microsoft Office Button  and choose Excel 
Options. On the Advanced pane, click to deselect Show 
a zero in cells that have zero value in the Display options 
for this worksheet group. Click OK.

12.  Press �  and then press � . Click to select 
Show Margins. Drag the left margin marker to set a 
1.50-inch margin.

 13.  Prepare and submit your work. Save and close the workbook.

Exercise 8-17
Use ROUND. Create nested functions.

 1.  Open CASupplies. Save it in your Lesson 8 folder as [your initials]8-17. 
Change to the Flow document theme.

 2.  Use ROUND and create a nested function by following these steps:

 a.  Click cell B18. Click the Formulas tab. Click the Math & Trig 
button  and choose ROUND.

 b.  In the Number argument box, click the arrow with 
the Name Box and choose AVERAGE again. The 
suggested range is B4:B17 for Number1.

 c.  Click cell B4 and drag to select cells B4:D17 as the 
Number1.

 d. In the formula bar, click anywhere in ROUND.

 e.  Click in the Num_digits box and key 0. Click OK.

 3.  Use ROUND and key a nested function by following these steps:

 a. Click cell B19. Key =rou and press .

 b. Key aver and press  to start the nested function.

 c. Select cells E4:E17 and key a comma to separate the arguments.

 d. Select cells F4:F17 and key ) to close the AVERAGE function.

 e. Key , to start the Num_digits argument.

 f. Key 0) to complete the ROUND function. Press .

NOTE

Subtract the start time from the finish 
time to determine hours worked.

NOTE

If AVERAGE is not in the Name Box 
list, click More Functions and find it in 
the Statistical or Most Recently Used 

category.

TIP

You can set a worksheet to show or hide 
zeros.
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EX-5LESSON 8 Rounding and Nesting Functions

 4.  Use either method to determine the average number of sundae cups 
ordered (columns G:I).

 5.  Format cells A1:A2 as 18-point Calibri. Format the labels in row 3 as 
Constantia 10-point. Apply Comma Style with 0 decimal places to all 
values.

 6.  Select the cells for cones ordered, and apply conditional formatting that 
shows the top five values in bold text with gray fill.

 7.  Click the Page Layout tab and the Dialog Box Launcher in the Page 
Setup group. On the Page tab, choose Landscape and Fit to 1 page wide 
by 1 page tall. On the Header/Footer tab, click Custom Footer. Prepare 
a footer.

 8. Prepare and submit your work. Save and close the workbook.

Exercise 8-18
Insert a hyperlink.

 1.  Open CACount and save it as [your initials]8-18 in your Lesson 8 folder.

 2. Insert a hyperlink by following these steps:

 a. Right-click cell G1 and choose Hyperlink.

 b. Click in the Text to display box and key Show Supplies Sheet.

 c.  Click the Existing File or Web Page in the Link to list.

 d.  Find CASupplies, click the filename, and click OK.

 3.  On the Home tab, click the Format button . Choose Hide & 
Unhide and then Unhide Sheet. Click CustCount (2) in the list and click 
OK. Repeat these steps to unhide CustCount (3).

 4. Add the same hyperlink to each of these sheets.

 5.  Group the sheets, right-click the column B heading, 
and hide it.

 6.  Click the Page Layout tab and open the Page Setup 
dialog box. Set landscape orientation. Add a header 
from this dialog box.

 7. Prepare and submit your work. Save and close the workbook.

NOTE

This hyperlink will open a file. You cannot 
insert a hyperlink on grouped sheets.
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Exercise 8-19
Use date arithmetic. Create a nested function.

 1. Open PastDue and save it as [your initials]8-19.

 2.  Select cells C4:C15. Replace all occurrences of “2005” with the current 
year. If, after replacing, some dates are in the future, change those cells 
to the same date but last year.

 3.  In cell D4, key a formula to compute the due date 
30 days after the invoice date. Copy the formula.

 4.  In cell E4, use a formula to subtract cell D4 from 
today. Format the result with no decimal places and 
negative numbers in red with no parentheses and no 
minus sign. You may not have negative numbers at 
this point. Copy the formula.

 5.  In cell F4, create an IF formula. The first logical test 
is that cell E4 be greater than 120 days. If this is so, 
the Value_if_true is Over 120. As the Value_if_false, nest 
another IF function. The logical test for the second IF 
function is that cell E4 be greater than 60. The Value_
if_true for this IF statement is Over 60. The Value_if_
false entry for the second IF statement is Acceptable. 
Right-align the results, and copy the formula.

 6.   Add a footer. Set a left margin to place the sheet more 
centered on the page.

 7.   Make a copy of the sheet. Hide columns A:C and 
display the formulas. Set this sheet to print Headings.

 8.  Prepare and submit your work. Save and close the 
workbook.

Exercise 8-20
Use time arithmetic.

 1. Create a new workbook and save it as [your initials]8-20.

 2.  Choose the Urban document theme. In cell A1, key Klassy Kow Parkland 
Shop. Key Part-Time Hours in cell A2.

Lesson Applications

TIP

You can limit a Find and Replace task to 
selected cells.

NOTE

Some customers might be very late, and 
some might show a negative number of 

days, meaning bills are not yet due.

NOTE

Headings and Gridlines are options on the 
Page Layout tab as well as on the Sheet 

tab in the Page Setup dialog box.
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 3. In cell B3:D3, key the following labels.

    Starting Time Ending Time Hours Worked

 4. In cell A4, key Monday.

 5. Key the data shown in the figure below.

Figure 8-13   A B C

 5 Keiko Yang 11 am 8:30 pm

 6 Eugene Sanchez 12 pm 10 pm

 7 Millie Hanes 9:30 am 4 pm

 8 Michael Bianciotto 10 am 5:30 pm

9 Aneta Monroe 2 pm 10 pm

 6.  In cell D5, key a formula to determine hours worked. 
Format the result as a Number with two decimal 
places. Copy the formula.

 7.  Format the sheet in an attractive, easy-to-read style. 
Add a header.

 8.  Prepare and submit your work. Save and close the 
workbook.

Exercise 8-21
Use date arithmetic. Use the INT function.

 1.  Create a new workbook and save it as [your initials]8-21. Set the Metro 
document theme.

 2.  Key Klassy Kow New Employees in cell A1. Key Birthday and Age in 
cell A2.

 3. Key these labels in cells A3:C3.

  Name Birthday Age

 4.  In cells A4:A10, key the first and last names of six persons. Use 
classmates’ or family members’ names, or create new names.

 5.  Key birth dates in column B for each of your employees. Format the 
birthdays in a date format of your choice.

REVIEW

Convert a fraction of a day to hours by 
multiplying by 24.

NOTE

When the time is on the hour, you do not 
need to key the colon or the zeros. Excel 
inserts them and capitalizes AM and PM.
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 6.  Key a formula that determines the person’s age as an 
integer.

 7.  Format your worksheet in a professional manner. Add 
a header or footer.

 8.  Copy the worksheet to prepare a formula sheet.

 9.  Prepare and submit your work. Save and close the 
workbook.

Exercise 8-22  Challenge Yourself
Create a nested function.

A nested IF statement in this worksheet determines the state with the 
maximum value for each product.

 1. Open JulyDrinks. Save it as [your initials]8-22.

 2.  In cell G5, start an IF function. Click cell B5 for the 
Logical_test, key = after B5, and nest the MAX function 
after the equal sign. Select cells B5:E5 as Number1 for 
the MAX function.

 3.  Click anywhere in the word IF in the formula bar. Key 
California in the Value_if_true box. Your function states 
that “California” will be displayed in cell G5 if the 
value in cell B5 is the maximum value in the range 
B5:E5.

 4.  In the Value_if_false box, nest a second IF function. For the Logical_test, 
click cell C5, key = after C5, and nest the MAX function with cells B5:E5 
as Number1. If California is not the maximum value, the function will 
test if cell C5 (Washington) is the maximum.

 5.  Click in the second occurrence of IF in the formula bar. In the Value_if_
true box, key Washington. “Washington” will be shown in cell G5 if the 
value in cell C5 is the maximum value in the range B5:E5.

 6.  In the Value_if_false box, nest a third IF function. The 
Logical_test is D5 =MAX(B5:E5). Click in the third 
occurrence of IF, and key Oregon in the Value_if_true 
box.

 7.  In the Value_if_false box, key Nevada. If the value in cell 
B5, C5, or D5 is not the maximum value, then Nevada 
is. Click OK.

 8.  Center the results and copy the formula to row 9. Add a Top and Double 
Bottom border to cells B10:F10.

 9.  Select cells B5:E5 and set a conditional formatting top/bottom rule to 
show the largest value in bold. Repeat this for each item.

TIP

Nest the formula to determine age within 
the INT function.

NOTE

Do not include the Totals column as you 
check for the highest sales.

NOTE

The structure of the nested IF function 
does not require a logical test for the 

Nevada value.
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10.  Set the page to be horizontally centered. Add a footer.

11.  Copy the worksheet and display the formulas. Hide 
rows 1:3 and fit the columns to the visible data. 
Remove the horizontal centering, and fit this sheet to 
one landscape page.

12.  Prepare and submit your work. Save and close the 
workbook.

TIP

Use the Page Setup dialog box to remove 
horizontal setting and fit the page.

In these exercises you work on your own, as you would in a real-life work 
environment. Use the skills you’ve learned to accomplish the task—and be 
creative.

Exercise 8-23
In a new workbook, key your name and the names of three family members 
in a column. In the next column, key birth dates for this year for each 
person. In the third column, calculate the number of days until the person’s 
next birthday. Select a document theme and use your own format choices 
to make the worksheet attractive. Add a footer. Save the workbook as [your 
initials]8-23. Prepare and submit your work.

Exercise 8-24
Open PerfRating and review the nested IF function in column E to 
determine how an increase is calculated. Make a copy of the sheet and 
delete the contents of column E and re-create the nested IF function. 
Format the sheet in a professional way. Add a footer and save the workbook 
as [your initials]8-24. Prepare and submit your work.

Exercise 8-25
Create a new workbook with a list of 10 persons’ first names in column A. 
In column B, key each person’s height in inches. In column C, use an IF 
formula to show “Tall” if the person is 72 inches or more, “Average” if 
the person is between 63 and 71 inches, and “Short” if the person is less 
than 62 inches tall. Add labels and format the sheet with your own design. 
Add a header. Save the workbook as [your initials]8-25. Prepare and submit 
your work.

On Your Own
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